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1 GENERAL
1.00 Introduction

The HCQ Navigator is part of the HAMM Compaction Quality System
(HCQ) for measuring, evaluating and documenting compaction results.
Before starting use, read this operating manual carefully from the
beginning in order to avoid mistakes and hazards occurring, and to
familiarize yourself with the correct and safe way to handle the system.
The operating instructions must always be present at the place of
utilisation of the machine.
We constantly work on the further development of our products.
Therefore, please understand that we must reserve the right to
change the scope of the delivery in respect of the form, equipment and
technology at any time.
This edition is applicable to software version V2.4.X and relates to
the Panel PC Xplore iX104C5 with the Microsoft Windows 7 operating
system.
The manufacturer has already integrated this operating manual into
the HCQ Navigator software. HAMM will not be liable for any damage
arising from the use of this edition with any program version other than
the one described here.

1.01 Guarantee
No guarantee claims with:

Operating errors.
In the case the spare parts used are no original HAMM spare parts.
In the case the spare parts used are no original HAMM accessories.
In the case any additional devices / parts have been refitted and/or
installed that have not been approved by HAMM.
In the case of deficient maintenance.
In the case of any processes that conflict with these operating
manual.

 

1.02 Packaging and dtorage
We have carefully packed our products to ensure proper protection
in transit. Please check both packaging and the goods yourself for
any damage upon reception of your goods. In the case of damage,
the devices must not be put into operation. Damaged cables and
connections are a safety risk and must not be used.
In such a case, please contact your supplier.
If the devices are not put into operation upon unpacking, they must be
protected against humidity and dirt.

 

1.03 Signs and Symbols
The signs and symbols used in this operating manual are to help you
use this operating manual and the device in a safe and fast manner.
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Note Informs about application hints and useful information. No
dangerous or harmful situation.

Enumeration Indicates a listing of issues or possibilities.

Operating steps Are listed according to their succession each starting from 1 for
each individual process.

Cross-references Cross-references help you to find quickly sections in this operating
manual which supply you with additional important information. The
cross-reference shows you the page of the relevant section. 
The abbreviation sqq. means "and the following pages".
Example: (see page 134 sqq.)

Positioning of illustrations The positions of illustrations are represented with letters. The positions
identified with letters in alphabetical order are only explained in the
corresponding text segment, beginning new for each single figure.
The end of the positioning line is marked as dot or arrow. In the
illustration the dot marks a visible element and an arrow an invisible
element which is in arrow direction.

Menus and menu lines Text references to menus and menu lines are shown in bold.

Dialog box Text references to dialog boxes are shown in bold italics.

Areas in Dialog boxes Text references to areas in dialog boxes are shown in italics.

Buttons and keys Text references to buttons are in quotation marks.

1.04 Signal Words
A signal word identifies a source of dangers and residual risks.

 DANGER
Identifies immediate danger. If this risk is not prevented, this causes
death or severe personal injuries.

 

 WARNING
Identifies situations that may be dangerous. If this situation is not
avoided, fatality or very serious injuries may be caused.

 

 CAUTION
Identifies situations that may be dangerous. If this situation is not
avoided, minor or light injuries may be caused.
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NOTICE
Refers to a situation that may cause property damage.

 

1.05 Safety Instructions
The HCQ Navigator and the associated system components have been
produced according to the state-of-the-art. However, danger for life and
health of the user or impairment of the machine and of other objects can
arise due to their function during the use of the machine.
Read and comply with the following safety instructions before using the
product.

When using the HCQ Navigator together with a roller, also observe
all the safety instructions and hazard warnings involved with using
the particular roller.
Read the relevant instruction manual for the proper and safe use of
the additional equipment.
Only trained or instructed personnel be used.
Configurations and settings may only be made by trained and
instructed skilled personnel with knowledge of the machine
engineering and the Continuous Compaction Control (FDVK).
This must be switched off during all assembly work on the roller.
When installing the DGPS-(Differential Global Positioning System)
receiver ensure that you have a secure footing.
Only use the rubber-tipped pen supplied (digitiser). Other objects
damage the surface of the touch-screen of the Panel PC. Such
repairs are not covered by the warranty of HAMM AG.
Electrical connections may only be made to standardized earthed
sockets. Do not use damaged power cables. Disconnect the
electricity supply before changing locations.
Do not use the HCQ Navigator near radios or television sets. This
could cause radio frequency interference.
Do not install the Panel PC near electromagnetic fields. This can lead
to loss of data on the hard disk.
Always keep batteries fully charged to ensure that they are always
ready for use.

1.06 Intended Use
The HCQ Navigator and the associated system components may only
be used in technically unobjectionable condition, as well as according
to the intended use, and aware of safety issues and possible dangers,
always observing the operating instructions. Use under improper
conditions can cause the following serious situations:

Danger to the well-being of the user or third parties
Adverse effects on the machine and other physical assets of the
user
Endangering the efficient, cost-effective working of the complete
system
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Proper use is deemed to be using the HCQ Navigator for Continuous
Compaction Control (FDVK) of earthworks and asphalt laying. Only use
of the product components supplied in the specified form is accepted.
Proper use also includes following the operating manual and thus the
manufacturer's guidelines.
Die HAMM AG does not accept any liability for consequences or
damages arising from improper use of this product. In such cases the
user will bear the complete risk. Unauthorized changes of the product
will exclude the manufacturer's liability for any damage resulting from
this.
As the HCQ Navigator is software supported, reference is made to the
currently valid guidelines for working with a visual display unit.
The scope of supply includes a specific manual for the Panel PC. The
warning, safety and working instructions in this manual must also be
observed.
The HCQ Navigator has been developed for use with rollers. There are
separate operating manuals for these machines and other components.
They contain warning, safety and working instructions which must be
observed, independently of this operating manual.
Please contact your local Wirtgen Group Service Partner in the event of
technical problems or for more detailed information that is not contained
in this edition.

1.07 Disposal
Conservation of nature is one of our major tasks. Properly disposed
devices avoid negative impacts on human beings and the environment
and allows re-using our precious resources.

Materials (metal, plastics) To be able to dispose materials professionally, these materials need to
be correctly sorted. Cleanse materials of adhesive impurities.
Please dispose all materials as demanded by local provisions of the
relevant country.

Electical / electronic system /
battery

The electrical / electronic components are not subject to
directive 2002/96/EC and the corresponding national laws (in Germany
e.g. ElektroG)
Dispose electrical / electronic components directly at a specialised
recycling company.

1.08 Application possibilities of the HCQ Navigator
Guiding and checking the 
compaction process

Compaction measurement and in-
dication the stiffness

Checking unbonded layers con-
sisting of non-cohesive mixed
grains, sands and mixed grain 
soils with a low 
fine-grain fraction

Continuous 
compaction control and evalua-
tion (FDVK)

Uniform compaction with the 
minimum number of passages
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Minimisation of sources of errorDetection of defective and weak
spots Localization of non-visible blocks

and filled-in 
trenches

Calibration of selected points with
static plate load tests or other
methods

Calibration diagram

Calibration

Automatic determination of regres-
sion line

Control of the work plan (test
method M3)

automatic storage of measuring
values

Statistical evaluation Statistics window

Derivation of 
compaction rules

Cut function

 

Areas of application road construction
landfill construction.
dam construction
airport construction
railway line construction
industrial construction sites
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1.09 Functions and features
General Fast familiarization through the 

use of conventional icons

Adjustable user interface to give
the driver a better overview

Simple, 
user-friendly operation

Transreflective touch-screen

Precise DGPS 
position finding

Continuously adjustable zoom

Digital planning data can be used
as an aid to orientation

Simplest orientation even on
large building lots

System can be used without first
entering planning data

Data transfer by means of the 
supplied USB 2.0 stick

Clear data management and
archiving

Subsequent processing with stan-
dard software

Print function On the Panel PC via a PDF / di-
rectly on the office computer

Office software The software CD included in the 
scope of supply can be used 
without restriction

Export function Exports the recorded measured
data for further use in other soft-
ware

Advantages for the driver Display the current 
compaction status

Monitoring of the 
rolling process

Compaction only where it is re-
quired

Quick reactionDetection of weak points
Search for weak points

Prevention of under and 
over compaction

Flexible compaction work

Time savings

Efficient compaction work

Saving of diesel fuel

Work record Unbroken documentation of the
compaction results
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Advantages for the employer Complete record of the com-
paction work done for the building
clients

Avoidance of 
warranty costs

Instrument for self-monitoring

Optimal quality assurance

Control of the work done on the
site

Search for weak pointsDetection of weak points
Rectification of weak points (soil
replacement, soil improvement),
reduction of 
conventional measurements

Advantages for the building
owner

Clear, easily understandable 
compaction log

Selective re-examinations can be
done quickly

Control of the work plan

Necessary actions can be taken
immediately
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2 DESCRIPTION OF HARDWARE
The degree of compaction and bearing capacity are important
parameters for the ground quality of soil layers. 
The HCQ Navigator enables a satellite supported area compaction
control even while compaction is taking place. So the measurements are
recorded during rolling process.
The driver can see the number of passes, the asphalt temperature, the
compaction and the quality of the compaction, as well as other things on
the screen. Thy system saves the compaction temperature and position
data. 
It also provides comprehensive possibilities for the continuous and
reproducible documentation and analysis of compaction results.

Before a measuring pass, the site management has to create
a project containing the necessary project parameters (see
page 64).

2.00 Method of operation of the HCQ Navigator
Example of compactor The vertical vibrations of a drum are generated by rotating the vibrators

inside the drum. As a rule, vibrating rollers are equipped with a large
and small amplitude. An appropriate frequency is assigned to each
amplitude.
The distance is measured and the position found via the receiver of a
Differential Global Satellite Navigation System (DGNSS).
 

The activated drum together with the subsurface form a vibrating
system. This changes its behaviour as the compaction of the ground
increases.

The sensor is mounted on the vibrating components of the drum. It
measures the ground reaction in the form of a vertical acceleration, and
converts this into a measured compaction value. The calculated HAMM
measured value (HMV) describes the stiffness of the ground.
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The current HMV is indicated to the operator on the instrument panel,
either by an analog dial or a bar diagram (see the manual for the
particular machine).

The position of a roller can be determined from the signals from at least
4 satellites of a Global Satellite Navigation System (GNSS).
A DGNSS receiver is used to meet the requirements for Continuous
Compaction Control, which achieves an accuracy in the decimetre range
by means of a differential or correction signal. A DGPS receiver is used
as standard for the HCQ Navigator.

The compaction and position data are combined and prepared for
visualisation. Complete documentation and evaluation is thus possible
even while compaction is taking place.

2.01 Scope of delivery
The individual components of this HAMM Compaction Quality System
are optimally matched to one another.
Compactors pre-equipped with the HCQ Navigator, are fitted in the
factory with the HCQ Indicator, speed and frequency displays, and
corresponding holders. All functions for evaluating the measurement
results are integrated into the HCQ Navigator. No additional systems are
required.
The individual components of the HCQ Navigator are supplied in a
lockable suitcase.
After the components have been removed, the case must be kept in
a safe place, so that the components can be stored safely if they are
temporarily taken out of use.
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[A] Panel PC with touch screen
and digitizer

[B] Power packs / Power cable /
DGPS connecting cable / USB
2.0 stick

[C] Panel PC and DGPS receiver
manuals

[D] DGPS receiver with magnetic
feet

2.02 Technical Data
Please refer to the manuals supplied for the technical data concerning the Panel PC and the receiver.

2.02.01 Conditions for Operation, Storage and Transport
Panel PC (iX104C5 DMSR) Receiver

Weight 2.4 kg 1.9 kg

Operating tempera-
ture

–34 °C to +60 °C –30 °C to +70 °C

Storage tempera-
ture

–51 °C to +71 °C –40 °C to +85 °C

Casing – Protection class IP67 (dust and water
resistance)

– UV resistant
– Robust resistance to vibrations, im-

pacts and other environmental effects
(tested according to MIL-STD 810G)

– Protection class IP65 (dust and water
resistance)

– UV resistant
– Resistant to vibration and shock ac-

cording to MIL-STD 810E/F

Please refer to the supplied Panel PC and receiver manuals for further information.
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2.03 System components of the HCQ Navigator
Example of compactor

[A] Compaction meter (drum, left) [B] Central electrical system with
compaction computer

[C] Panel PC (in holder) [D] Dial in instrument panel

[E] Receiver

2.04 DGPS receiver

2.04.01 Installation Location of Receiver

[A] Roller roof [B] Connecting cable

[C] DGPS receiver [D] Marking
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2.04.02 Receiver
DGPS receiver

[A] Magnetic feet [B] Connection panel

[C] Receiver casing

Optional RTK receiver

[A] DGPS receiver [B] Modem (only when used with
real-time kinematics - RTK)

[C] Radio antenna connector [D] Connector plug

2.04.03 Receiver connection panel

[A] Port A — HCQ interface [B] LED receiver status

[C] Port B — modem interface

Port A / Port B Both connectors can fulfil the following functions:
Serial communication to the HCQ compaction computer
Communication to the radio modem, if the DGPS difference signal is
taken from a local base station.
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LED indicator The following tables describe the sequences of control lights for the
individual positioning methods.

LED sequence for WAAS / Egnos and Omnistar VBS

LED colour LED 
condition

Status

Off Off No power supply

Green steady light Normal operation: calculation of DGPS
positions (Differential Global Positioning
System)

Green flashes 
slowly

No DGPS corrections: Calculation of DG-
PS positions using old correction data

Green flashes
quickly

No DGPS corrections reach the DGPS
age limit: Calculation of DGPS positions
using old correction data

Yellow steady light DGPS corrections are received, but no
DGPS positions are calculated yet: calcu-
lation of autonomous GPS positions

Yellow flashes 
slowly

No DGPS corrections: calculation of au-
tonomous GPS positions

Yellow flashes
quickly

Not enough GPS signals: Number of
tracked satellites too low to 
calculate positions

WAAS/EGNOS, OmniSTAR VBS and OmniSTAR HP use the
satellite-supported differential GPS positioning method.

LED sequence for RTK positioning

LED colour LED 
condition

Status

Off Off No power supply

Green steady light Normal operation: calculation of 
Fixed-RTK positions (Real Time Kine-
matik)

Green flashes 
slowly

CMR corrections received, but not ini-
tialised: calculation of Float-RTK positions

Green flashes
quickly

No CMR corrections: Calculation of RTK
position using old correction data

Yellow steady light CMR corrections received, but RTK posi-
tion cannot be calculated: Calculation of
the DGPS (if WAAS/EGNOS is not avail-
able) or autonomous position.

Yellow flashes 
slowly

No CMR corrections: Calculation of the
DGPS or autonomous position

Yellow flashes
quickly

No reception of CMR corrections: No po-
sitions are calculated
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LED sequence for OmniSTAR HP positioning

LED colour LED 
condition

Status

Off Off No power supply

Green steady light Normal operation: Calculation of con-
verged OmniSTAR HP positions

Green flashes 
slowly

Reception of OmniSTAR HP corrections,
but only an unconverged position can be
calculated

Green flashes
quickly

Reception of OmniSTAR HP corrections,
but an HP error has occurred

Yellow steady light Reception of OmniSTAR HP corrections,
but no position can be calculated Calcula-
tion of a DGPS or autonomous solution.

Yellow flashes 
slowly

No OmniSTAR HP corrections: Calcula-
tion of a DGPS or autonomous position

Yellow flashes
quickly

No OmniSTAR HP correction data are
tracked: No positions

2.05 Panel PC
Front view

[A] Microphone [B] Loudspeaker

[C] Function indicator [D] Brightness sensor

[E] Reset button [F] PC status indicator

Reset button
The Panel PC can be switched off with the Reset button, if inputs are no
longer possible and the ON/OFF switch does not work.

Status display
The current status of the Panel PC is shown by the status indicator (on,
off etc.).
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Brightness sensor
The brightness sensor checks the light conditions and regulates the
screen lighting.

Function indicator
The hard disk activity is shown here.

Rear side

[A] Battery [B] Digitiser holder

[C] Battery catch [D] Battery lock

[E] Certificate of Authenticity [F] Series number

[G] Digitizer [H] Camera

Battery
The battery supplies the energy when the Panel PC is not connected to
a power supply.

Battery catch
The catch holds the battery in the Panel PC.

Battery lock
The lock secures the connection to the battery.

Digitiser holder
For holding the digitiser when it is not in use.

Digitizer
The digitiser (rubber tipped pen) is the standard tool for navigation and
operation within an application.
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Left side

[A] On / off switch

On / off switch
The On / Off switch:

switches the Panel PC on and off.
switches the background lighting on and off.
activates/deactivates stand-by mode.

Right side

[A] Power input [B] USB 2.0 interfaces

[C] Headphone / speaker
connector

[D] Microphone connection

[E] LAN connection [F] VGA interface

Power input
Power supply with power pack

USB 2.0 interfaces
Connection of USB 2.0 devices (e.g. mouse, keyboard, USB stick)

Headphone or speaker connector
Stereo headphones or speaker connector

Microphone connection
Connector for external microphone

LAN connection
Standard connection RJ-45

VGA interface
Connection of an external monitor
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LED display The LEDs indicate the system status.

[A] Status indicator [B] Brightness indicator

[C] Function display

Status indicator

green, steady light The PC is switched on and the battery is fully
charged.

green, flashing The power unit is connected. The battery is
recharging.

no light The PC is switched off.

yellow, steady
light

The PC is switched on and in stand-by mode.

yellow, flashing The PC is switched on and in the warm-up
phase. LCD and background lighting are still
switched off. They switch on automatically after
the warm-up phase.

red, flashing The PC is switched on in battery mode. The bat-
tery is at minimum charge. The power unit must
be connected to the power supply.

red, steady light – The PC is switched on in battery mode. The
battery charge is at critical level. The power
unit must be connected to the power supply.

– The PC is defective (please contact your Wirt-
gen Group Service Partner).

Brightness indicator

yellow, steady
light

Automatic brightness control is activated.

no light This is the default setting. The brightness control
can be set manually.

Function display

green, steady light The hard disk is ready for operation.

no light The hard disk is not ready for operation.
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Function Keys The function buttons provide direct access to relevant program
functions.

[A] Safety key [B] Format switch

[C] Function key Fn [D] P3

[E] P2 [F] P1

Safety key (do not touch)
Block computer

Format switch
To select portrait or landscape format

Function key Fn
Button not in use

P1
Record measuring point

P2
Reduce

P3
Increase

Digitizer NOTICE
Pointed objects will damage the touch-screen!
When operating the HCQ Navigator with the touch-screen, do not use
any objects which could damage the touch-screen! Such repairs are not
covered by the warranty of HAMM AG.

 
The digitiser is a pressure-sensitive pen with a rubber tip used for
operating the Panel PC.
The digitiser performs the essential functions of a mouse for navigation
and operation within an application. It is attached to the back of the
Panel PC.
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The following functions are executable:

Function Version

Select object Touch object with pen

Double-click Double-touch object with pen

Right click Position the pen on the object for
about 1 second

Drag & Drop Position the pen on the object,
drag it across the screen, and
drop it at the desired position.

2.05.01 USB mouse
The usual navigation options can be used if a USB mouse is connected.

2.05.02 Keyboard
USB keyboard If a keyboard is connected, all the navigation options of a conventional

keyboard can be used (e.g. cursor keys).

On-screen keyboard In the various input dialogs, the screen keyboard can be opened with the
"Change" buttons or the Keyboard icon. In this way, all the navigation
options of a conventional keyboard can be used (e.g. cursor keys)..
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2.06 Central Electrical System of the HCQ Navigator
Installation locations

[A] Driver's seat [B] Steering column

[C] Panel PC holder) [D] Instrument panel

[E] Central electrical system

[A] Printed circuit board of HCQ
central electrical system

[B] Compaction computer HCM
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2.06.01 Panel PC power supply
During operation in a roller, the Panel PC is supplied with power from the
vehicle's PC holder. This is connected to the on-board electrical system
of the roller.

[A] Central electrical system [B] Vehicle's PC holder

The Panel PC can be used outside a roller as follows:
External power supply - with a power unit
Internal power supply - with a battery

(see page 52)

2.07 Control and Operating Elements
Overview of the instrument

panel of a compactor
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Overview of the instrument
panel of a series HD+

Overview of the monitor
display of a series DV

2.07.01 HMV indicator
The HAMM Measurement Value display (HMV, the indication of the
compactors in the figure) indicates to the driver the current stiffness and
the maximum possible compaction that can be attained with the roller.

Needle rises:
Material can be compacted - further passes are required!
Needle stops rising:
Maximum compaction has been attained - stop compacting.
Needle falls:
Drum is in jump operation or the material cannot be compacted
(cohesive soil with an excessive water content).

HMV value
The HAMM Measurement Value (HMV) corresponds to the actually
measured, relative compaction value. This value provides information
about the ground compaction achieved, and shows the driver where the
ground still needs to be compacted and where compaction is already
complete. Subareas which are differently compacted (e.g. areas which
are difficult to compact or are non-compactible) can thus be delimited to
make the compaction work more efficient.
As a rule, each passage increases the HMV of a layer which is being
compacted. The absolute HMV and the increase in compaction per
passage depend on the type of roller, the set machine parameters
(speed, frequency and amplitude) and the compacted subsoil (layer
thickness, water content, type of ground).
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If a repeated passage over an area does not increase the compaction
or change the HMV, the particular roller must not be used for further
compaction. The compaction work is finished as soon as the desired
compaction result has been achieved. Otherwise, further measures must
be taken (e.g. using a different roller, drying out the subsoil, changing
the compaction material).

2.07.02 Resonance Meter Value (RMV) indicator (not present in all machine
series)

Example of compactor The illuminated display of the Resonance Meter Value (RMV) serves
as a jump operation warning light. The light flashes slowly or quickly
depending on the intensity.

Cause Elimination

Incorrect amplitude Change from large to small amplitude (vi-
brator

Maximum compaction has
been attained

Stop compacting

Machine too light Use a heavier machine (especially in the
case of rock)

RMV indicator (jump
operation)

The resonance meter value (RMV) describes the jump operation of a
vibrating drum as a result of an unfavourable combination of machine
type, machine parameters (e.g. frequency and amplitude) and the state
of the compacted subsoil. The RMV provides information about the drum
possibly lifting off the ground if the subsoil is very stiff.
The behaviour of the roller changes markedly in jump operation.

Characteristics of jump
operation

Results

Strong vibrations, higher
noise level

– Severe ergonomic stress on the roller
driver

– Severe stress on/damage to the roller
– Noise pollution of the environment

Falling HMV 
(half amount)

Loosening of the ground

RMV indicator flashes Drum approaching jump operation

RMV indicator lights Drum in jump operation

Switch to the small vibration amplitude if there is any sign of jump
operation! If the RMV indicator flashes or lights up after the change, stop
compacting and, if necessary, use a different roller.

Jump operation is forbidden during the last passage of a
Continuous Compaction Control (FDVK)!

Please refer to the corresponding operating manual for
information about vibration / oscillation of the HD+ or DV
machine.
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3 DESCRIPTION OF THE SOFTWARE

3.00 User interface

A Drop-down menus B Toolbar

C Button bar D Display frame

E Display fields F Legend

All the required settings for the actual project can be made on the
program interface, new projects can also be created, and a wide range
of evaluations made.
The pull-down menu line and the toolbar can be hidden with the "Show/
hide menu" button in order to obtain a clearer view during the rolling
process / compaction.
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The following information can be read on the Panel PC during the
compaction process:

Earthmoving Asphalt laying

Number of passes

Soil stiffness (HMV)

Compaction change Temperature

EV1 / 2 / d

RMV

Frequency

Amplitud

Cross section

Speed

Absolute height

Satellites

3.00.01 Title bar
The title bar above the screen window indicates the name of the project,
the site section and the layer.

3.00.02 Drop-down menus
The following menus are arranged in this line:

File
Site
Communication
View
Planning data
Analysis
Options
?

File
The File menu contains important standard commands such as Open,
Create new project, Import / Export data and Print.
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Site
The Site menu contains commands for configuring the project
parameters.

Communication
The Communication menu opens the Communication window with the
list of all rollers in the WLAN group.
New rollers that have to be added to the group can be connected here.
When the program starts, an error message appears if there is no to the
WLAN connection to all the machines switched to active.

View
The View menu contains the main standard commands for zoom,
screen segmentation and window displays.

Planning data

The Planning data menu is only available to "Expert" and
"Service" users.

This menu contains the commands required to input digital information
about the landscape and the locality (e.g. maps) into the measurement
and position data, and to adjust to the map / map position.

Analysis
This menu contains a range of evaluation options.

Options
The Options menu contains the main standard commands for setting
the languages, units of measurement, and project paths.
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?
This menu provides a short description of the program and states the
version being used.

3.00.03 Toolbar

The toolbar contains buttons for quick access to program functions:

Find
Provides information about a freely selectable position within a display
frame. The point to be investigated is selected by a single stationary
touch and a short movement of the digitizer, and indicated by a cross.
The available information appears on the left in the bottom bar.

Distance
Distance measurements within a displayed area. The distance is
measured by touching once, and dragging within a displayed area. An
arrow indicates the distance and direction of the measurement. The
distance information is in the status bar (bottom left).
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Printing
The Print window dialog box opens for printing, for selecting the
window to be printed, and for configuring a connected printer, similarly to
the printer setup command in the File menu.

Cross section
Evaluation of the compaction development in a diagram (separate
window, see page 47).

Increase
Magnifies the measurement and evaluation data for the detailed view.

Reduce
Reduces the size of the measurement and evaluation data to give a
clear view.

Zoom
Continuously adjustable magnification of a specific area.

Adapting
Adjusts the size of the visualization to the display window.

Position
With an active window, the Point analysis dialog box, in which the
selected position is evaluated, is opened by setting a point.
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3.00.04 Button bar

The buttons provide quick access to the most important program
functions.

Show/hide menu
Shows/hides the menu bar with the buttons and display areas, and
deactivates filter settings. This makes the maximal screen area available
for the graphic compaction documentation, and simplifies the touch-
screen operation.

Archiving
This button creates a copy of the complete site data, with date and time
stamp, on the external data storage device (USB stick). Clicking the
button opens the window to select the storage location.

View
Opens the Window dialog box to select predefined views.
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Layer selection
Opens the Layer selection window to select predefined layers for the
current compaction documentation.

Inputting Measuring Points
Clicking the button saves a measuring point with the current geoposition.
The measuring points are further processed in other menus in
configuration mode.
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More information and work instructions
This button calls information that the driver needs for correct
performance of the compaction work. In the case of earth work with a
calibrated HCQ system, this is the specification of the work parameters
that have to be maintained, such as driving speed, set amplitude and
vibration frequency.

Start / Stop
This button starts and stops the recording of compaction measurements.
The communication states are indicated by two icons "Recording on"
and "Recording off", which are shown alternately.
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Online / Offline
Communications link to the roller. This button is used to show/hide the
evaluation of the geo position in the graphic view. The cross hairs are
visible when the link is activated, and they show the exact geo position
of the centre of the front roller drum.

Geographical orientation
The geographical orientation of the graphic view is only shown if the
system is in neither warning nor error state. Then the button can be used
to turn the orientation anticlockwise in steps of 45.

3.00.05 Display fields

Display of system status and geographical orientation
If the system is in warning or error state, these icons are used to
visualise the main system state of the machine:

Warning: The warning state indicates a problem which restricts but
does not prevent documentation of the compaction. If the warning icon is
activated, a short explanatory text appears in the warning text line at the
top right.
Faults: The compaction documentation cannot be recorded in error
state.

Geo position indication
The current geoposition of the centre of the front drum according to the
set coordinate system is shown alongside the icon. The colour of the
icon indicates the accuracy of the signal.

Display of machine info
The type of machine used and the works number of HAMM AG are
shown alongside the icon.
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Driving speed indicator
The current driving speed is shown alongside the icon in the pre-set
view.

Display of work mode
The current work parameters are shown here with icons and numerical
text. The top line refers to the front drum and the bottom line to the rear
drum. There is no second line in the case of rollers with only one drum.

– Front roller drum
Operation with vibration

Operation with oscillation

Static operation with steel drum

Static operation with rubber-wheeled drum

– Rear roller drum
Operation with vibration

Operation with oscillation

Static operation with steel drum



 Description of the Software
 User interface

© HAMM AG 2013 2356591_00_BAL_HCQ_H900_en 41

Static operation with wheelset

Display of ground compaction measurement
Information about the ground compaction is shown here with icons and
numerical text.

Icon during earth work

Icon during asphalt work

3.00.06 Display frame

Various views of the measurement and position data, or analysis values
(passages, compaction, quality of compaction, cut, statistics, etc.) are
shown in the display frame. The maps or geo lines included in the
project can also be displayed to improve orientation on the site.
The orientation of the site, the scale and the name of the current view
are shown in the bottom part of the views. The colour scale enables the
displayed measured values (value range and compaction quality) to be
quickly recognised.
The visualization can be displayed by a single view covering the entire
screen or in two display frames.
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3.00.07 Legend
The following information is given in the legend according to the set
window and tools used:

Scale of the view
Name of the window
Assignment of colours to numerical values
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3.01 Projections

3.01.01 Maps
Maps are useful options for orientation on the site (e.g. earth work, for
the construction planning, and for documenting the compaction results.

After the processed bitmap has been saved, two files are created in the
directory \HammHcqData\Maps. Both have the name of the bitmap. The
only difference is in the file extension.

HAMMLandKarte (*.hlk) contains the actual graphic.
HAMMDatenReferenz (*.hdr) contains the description of the
reference points with the orientation data (displacement and rotation)
of the graphic.

All Windows bitmap types (*.bmp; 24 bit, 256 colour, 16 colour,
monochrome) can be imported.
The white areas of the imports are shown transparent. so measurement
data on white areas of the bitmap are not covered.

3.01.02 Geolines
Geo lines are useful options for orientation on the site (e.g. motorway
construction, road building), for the construction planning, and for
documenting the compaction results.
Geo lines are supplied by the local construction planning office (e.g.
surveyor) in the form of files (text file, Excel list), and have to be
manually integrated into the project. Each geo line comprises two files,
with the same name but different file extensions.

HAMMgeolines (*.hgl) - The individual positions of a geo line
are noted in this file in Cartesian form according to Gauss-Krger.
However, as the measured data supplied by the DGPS receiver are
saved in angular coordinates (WGS 84), the program transforms the
coordinates. This achieves a congruence of the differently notated
position data.
HAMMDataReference (*.hdr) - Contains the data required for
georeferencing, and so is used to transform the coordinates. With the
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aid of this coordination file, the geo lines and the DGPS data can be
converted into a uniform notation, and then shown in the displayed
area.

 

3.01.03 View of Passages
Depending on the configuration, the "Passages" view shows the number
of drum or roller passages in colour.
Dynamically tracking cross hairs show the current position of the centre
of the front drum.

The "Change" button opens the dialog box for setting the colours.
Available colour combinations can be selected in its preset palettes
area.

3.01.04 Views of the Measured Ground Firmness Values
Online measurement with the Measured Ground Firmness Values views
requires equipment with HCQ Earth Work.
The "Change" button opens the dialog for setting the colours in all
Measured Ground Firmness Values views. The scale has 16 divisions.
Another two areas indicate values below the minimum value or above
the maximum value. The minimum and maximum values can be
changed manually. When the "Scale" button is clicked, the HCQ
software searches in the active layer for the lowest and highest value,
and so automatically determines the minimum and maximum values.
Available colour combinations can be selected in the preset palettes
area.
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HMV view The HMV view shows the HMV of the ground firmness in colour. The
HMV is the basic measured value of the ground firmness in the HAMM
HCQ System. The range of values lies between 0 and 150.

EV views The EV2 view shows in colour the EV2 ground firmness calibrated on
the HMV in the unit MN/m².
This requires a calibration to have been assigned to the active layer
in the layer setting. The prerequisite for an exact measurement is
adherence to the compaction parameters specified by the calibration.
These are:

Driving direction
Driving speed
set amplitud
Vibration frequency

EV1, EVD, ...
Functionally, these views correspond to the EV2 view, but they are
based on different calibration methods. The same conditions apply as for
EV2.
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3.01.05 Compaction Change View
The Compaction change view shows the relative percentage change in
the ground firmness compared to the previous passage. A positive value
indicators that the compaction has increased since the last passage, a
negative value indicates a decrease in compaction or a loosening of the
subsoil.

The "Change" button opens the dialog for setting the colours. The scale
has 16 divisions. Another two areas indicate values below the minimum
value or above the maximum value. The minimum and maximum values
can be changed manually. When the "Scale" button is clicked, the HCQ
software searches in the active layer for the lowest and highest value,
and so automatically determines the minimum and maximum values. A
colour can also be defined to indicate an undefined state. This applies
to the first passage over an area when there is no relative reference to a
previous passage.
Available colour combinations can be selected in the preset palettes
area.
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3.01.06 Temperature View
The temperature view shows the asphalt temperature in colour.

The "Change" button opens the dialog for setting the colours. The scale
has 16 divisions. Another two areas indicate values below the minimum
value or above the maximum value. The minimum and maximum values
can be changed manually. When the "Scale" button is clicked, the HCQ
software searches in the active layer for the lowest and highest value,
and so automatically determines the minimum and maximum values.
Available colour combinations can be selected in the preset palettes
area.
Online measurement with the temperature view requires equipment with
the HCQ Asphalt and an installed temperature measuring device.

3.01.07 Cut view
The Cut view enables a chronological curve of measured values along
a defined cut vector to be displayed. This function requires the screen to
be subdivided into two windows. One window containing the source view
to be examined, and the other the cut view.
A cut vector in the source window is defined with the cut tool in the
toolbar. The history of this line is shown in a Cartesian coordinate
system in the Cut window. The abscissa (X-axis) defines the distance
from the start of the cut vector. The ordinate (Y-axis) contains the
measured variable of the source data window (HMV, EV2, temperature
etc.). The Cut window shows a function of the measured value along the
path the for each of the up to 16 simultaneously displayable passages.
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The above example shows a cut vector of an Asphalt marshall density
window. The Cut window shows the increases in compaction for each
individual passage along the line defined on the left.

3.02 Dialog box
The pull down menus and buttons open the various dialog boxes used
for editing.
More detailed explanations on see page 55 sqq.
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4 MOUNTING / INSTALLATION /
COMMISSIONING

4.00 Prerequisites
The following conditions must be fulfilled so that the HCQ System can
work correctly:

Roller pre-equipped with:

connected DGNSS receiv-
er

Receiver unit for an existing differential
satellite navigation system, e.g. DGPS

DGNSS licence As a rule, a licence from a relevant
provider is required in order to use a
DGNSS signal.

DGNSS reception The receiver must not be too heavily
screened by obstacles, such as trees,
bridges or hills. Satellite signals cannot
be received in tunnels.

4.01 Power supply for system components
The system components are supplied with power by the on-board
electrical system as soon as the ignition is turned ON.
The Panel PCs can also be used outside the machine. It is then supplied
with power either by its internal battery or an external power supply.

4.02 DGNSS receiver
A GNSS receiver requires a line-of-sight link to at least 4 satellites of a
global satellite navigation system (GNSS), such as GPS or GLONASS,
to determine a position precisely. An additional correction or difference
signal (DGNSS) is required in order to achieve the precision needed
to operate HCQ. This can be transmitted either from a geostationary
satellite of a satellite-supported supplementary system (SBAS) or a local
base station (RTK).
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DGPS licence
DGPS receivers made by Trimble are used as standard for HCQ. They
work either with the free correction signal from WAAS / EGNOS or the
higher quality, chargeable OmniSTAR signals. Without a correction
signal (e.g. if there is no licence), the system does not produce any
reproducible, documentable measurement results (See Appendix for
positional accuracies).

Requirement and activation of a DGNSS licence
The OmniSTAR licences for various lengths of time can be obtained
from HAMM AG. Please contact your Wirtgen Group Service Partner.
It makes the selection and order of the required licence and states an
activation period.
You receive confirmation with date and time stamp, you also have to
have activated the HCQ GPS system on the machine.

Proceed as follows:
1. Place the machine, with mounted HCQ GPS, in an open space with a

clear view of the sky.
2. Activate the system about 15 minutes before the confirmed activation

time.

The system initialises itself and can be seen on the screen.

If initialisation does not take place, contact your Wirtgen Group
service partner and arrange a new activation time.

Installation

[A] Roller roof [B] Connecting cable

[C] DGPS receiver [D] Marking

 WARNING
Danger of falling! Danger of injury!
Only mount the receiver when the roller is switched off. When mounting
the device, make sure that you have a secure footing.
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1. Mount the DGPS receiver [C] with the magnetic feet on the mark [D],
which is glued on the left side of the machine roof.

2. Take the plug of the GPS cable [B] out of its holder and plug it into
the receiver [C]. 
The DGPS receiver is ready for operation.

Other GNSS receivers can be used with the HCQ. The
requirements for these receivers are to be found in the Appendix.

4.03 Panel PC

4.03.01 Mounting the Panel PC

 WARNING
Risk of short circuit!
Moisture and dirt can cause a short circuit.
Keep the spring contact of the PC interface clean and dry.

 

NOTICE
Magnetic fields cause data loss!
If the Panel PC comes into contact with magnetic fields, data may be
lost from the hard disk.
Keep the Panel PC away from magnetic fields.

 

In order to avoid radio interference, do not install the Panel PC
near a radio or television.

1. Push the locking lever [A] on the vehicle's PC holder down.
2. Place the PC in the open holder. 

The Panel PC is connected to the on-board electrical system of the
roller by the docking port [B] in the vehicle's PC holder.

3. Push the locking lever [A] on the vehicle's PC holder up.
4. Lock the PC in the holder with the key [C]. 

The Panel PC is ready for operation.

You will find more detailed information about operating the Panel
PC in the Panel PC Manual, which is included in the scope of
supply of the HCQ Navigator.
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4.03.02 External power connection to the Panel PC

 WARNING
Danger to life and limb by an electric shock!
Electrical connections may only be made to standardized earthed
sockets. Do not use damaged power cables. Disconnect the electricity
supply before changing locations.

 
To connect the Panel PC to the external power supply:
1. Switch off panel computer with on / off button (left side).
2. Connect the power cable to the power unit.
3. Connect the power unit to the power socket on the Panel PC.
4. Plug the power plug into an earthed socket.

4.03.03 Battery operation of the Panel PC

After a lengthy period of non-use and before use on a site,
connect the Panel PC overnight to an external power supply in
order to fully charge the battery.

The Panel PC can be run for up to 5 hours with the internal lithium ion
battery.
Check the battery status by means of the status LED [A] on the battery
each time before using it without an external power supply.

green Device is ready for operation

yel-
low

Device in stand-by mode

Red Critical state of charge (connect power supply via power unit!)
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4.03.04 Charging the battery of the Panel PC
Once the Panel PC is connected to the mains supply, charging begins
automatically if the remaining charge is less than 90 %.
The status LED flashes green during the charging process.

The battery is not recharged if it is already more than 90 %
charged. This prevents the battery from being overcharged.

The charging process is stopped automatically when the battery is 100
% charged.
The status LED lights green when the battery is fully charged.

The charging process for a completely discharged (7.4 V / 5700
mAh) battery supplied from the factory is about 2.5 hours.

4.03.05 Software installation
Panel PC The HCQ Navigator software is pre-installed on the Panel PC.

Office computer The HCQ Navigator software can be installed on a suitable office
computer to prepare, edit and analyse projects. Only the "Measuring
point", "Start / Stop" und "Online / Offline" buttons are not available.
System requirements
The following minimum equipment is recommended:

Operation system Microsoft Windows XP SP 2, Windows
Vista, Windows 7

Processor Pentium 3 (minium 500 MHz)

Memory 256 MByte RAM

CD-ROM drive

Administrator rights are required to install the software!

You will find additional information on the CD supplied. 
If you have any problems, please contact your local Wirtgen Group
Service Partner.

Opening the software on the
office computer

The software is called from the Windows Start menu (/ All Programs /
HCQ Navigator). Operation is the same as for the version on the Panel
PC.

4.03.06 Switching on

Please refer to the corresponding operating manual for
information about commissioning the roller.

1. Switch on the roller's ignition.
2. Check the functions before starting compaction.
3. Set the frequency and amplitude.
4. Switch the panel PC on with the On/Off button. 

After the Panel PC has booted up, the starting screen appears with
the user accounts "Driver", "Expert" and "Service".
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5. Click the user "Driver". The user interface, including the Open
project dialog box opens.

6. Make the necessary settings (see page 55 sqq.).
7. Start the measuring passage with the "Start" button. The

communications link must have been established (Online/Offline
button)!

NOTICE
Data is lost if the PC is undocked while recording!
Disconnecting the data link results in data loss.
Do not disconnect the Panel PC from the power supply or data link.
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5 OPERATING SOFTWARE

5.00 After switching on the unit
3 users with individual properties have been created the HCQ computer.
With the start of the software, the user is asked to log in as "driver",
"expert" or "service" (see page 53).
• Driver: The driver has the right to use the HCQ software and create

projects.
• Expert: The expert has the same rights as the driver, but he can also

delete projects and access selected Windows functions.
• Service: The Service user account is reserved for the Wirtgen Group

service partner.

After selection of the user "Driver" or "Expert", the HCQ software opens
with the Open file dialog box.
If a new project is to be created rather than an existing project to be
worked on, close the Open project dialog box and use File / New to
open the Create a new project dialog box.
In both versions, the required settings can be made in dialog boxes
afterwards (see page 61 sqq.).

5.01 HCQ Control Panel
If the "Driver" user account has been selected, the HCQ Control Panel
opens in the background at the same time as the HCQ software. It has
the following functions:
Time Options tab: For setting the current time and time zone

WiFi tab: Shows the status of the current WLAN connection and the
networks that are within range.
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Battery tab: Shows the battery charge level

Calibration tab: for calibrating the screen

Status tab: Shows the installed software versions

5.02 Calibrating the Screen
The screen can be calibrated if the Panel PC responds very inaccurately
to inputs made with the digitizer or finger.

Digitizer 1. Open the HCQ Control-Panel and select the "Calibration" tab. The
following view opens:
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2. Clicking the "Pen Calibration" button opens the Pen Tablet
Properties dialog box.

3. Select the category "Calibrate", and click the "Calibrate…" button to
start the calibration process.

4. Touch the crosses shown in the centre of the screen with the tip of
the digitizer.

5. Finish calibration with the "OK" button, repeat with "Try Again" or
cancel with "Cancel".

6. After calibration, close the Pen Tablet Properties dialog box by
clicking the "X" in the top right-hand corner.

Touch (with fingers) 1. Open the HCQ Control-Panel and select the "Calibration" tab. The
following view opens:
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2. Open the Touch Settings window by clicking the "Touch Calibration"
button.

The length of time to make a right-click can be set in the top
area.
Input by finger touch and outputting a sound with this touch can
be activated and deactivated in the lower area.
The "default" settings ("Default" button) are strongly
recommended!
Click the "Default" button in the categories "Pen" and "Pop-up
Menu" to restore any basic settings that have been changed.

3. Select the category "Calibrate", and click the "Calibrate…" button to
start the calibration process.

4. Touch the centres of the crosses shown one after the other on the
screen with a finger.
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5. Finish calibration with the "Finished" button. Go back one step with
"Back". Repeat calibration with "Start Over". Cancel calibration with
"Cancel".

6. After calibration, close the Touch Settings dialog box by clicking the
"X" in the top right-hand corner.

5.03 Adjust Language
German is the set language when the HCQ software is started for the
first time. Proceed as follows to select another language:
1. Select the Language item from the Options pull-down menu. The

Select languages dialog box opens.

2. Select the desired language from the list, and accept with the "Set"
button.

5.04 Setting units
Metric units are set when the HCQ software is started for the first time.
Proceed as follows to select other units:
1. Select the Units item from the Options pull-down menu. The Unit

selection dialog box opens.

2. Select the desired units from the lists, and click the "OK" button.
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5.05 Setting Paths
This option is only available for "Expert" and "Service".

 WARNING
Existing project directories are not moved! Projects can only be loaded
if the paths refer to the correct storage location (see page 92).

 
The first time the HCQ software is started, the HammHcqData working
directory is created in the Windows public user directory (This is usually
C:\Users\Public.). This contains all the other HCQ-specific subdirectories
(see page 92).
1. Select the Paths item from the Options pull-down menu. The

Assign subdirectories dialog box opens.

2. From the Find directory window that opens, select the desired paths
with the buttons on the right. Click the "OK" button in the Assign
subdirectories dialog box.
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5.06 Loading file
To load an existing project:
1. Select the Open item from the File pull-down menu. The Open

project dialog box opens.

2. Mark the desired site.
3. Select the desired section.
4. Use the "Load" button to confirm the selection.
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5.07 Projects

5.07.01 Create a new project
General When a new project is created, the HCQ Navigator software fetches a

pre-defined set of settings and project parameters from its database.
A project directory is created in the working directory under the selected
project name. The roller-related data (vehicle type, roller serial no.
etc.) are loaded automatically if there is a connection to a roller. These
machine data are always assigned to the relevant recorded data.
Depending on the project requirements, the existing project parameters
have to be configured and possibly newly created.

Creating and configuring a project is only to be carried out by
trained specialist staff (e.g., site manager) because knowledge of
the machine technology as well as the FDVK is necessary.

Creating project 1. Select the New item from the File pull-down menu. The Create a
new project dialog box opens.

2. Enter name of the site and possible comments.
3. Clicking the "OK" button accepts the inputs, and the project is created

with the standard settings.
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5.07.02 Importing a Project
Import an HCQ project into the existing project directory:
1. Select the Import project item from the File pull-down menu. The

Directories dialog box opens:

2. Select the location where the imported project directory is to be
stored.

3. Confirm with "OK". A successful import is confirmed by a message.

The imported directory must have the same directory structure
as the HCQ Navigator (see Appendix). If this is not the case, the
import will fail.

5.07.03 Exporting a Project
The entire data of a project can be exported and used in other programs.
To export data, select the desired export from the File pull-down menu:

Export Text: All the settings and the recorded measured values are
written in plain text in a *.txt file.
IC Export all Data: All the project data is written drum by drum to a
*.vexp file. This file is required for further use with the Veda software.
IC Export proof Data: Only the data of the last passage are written
drum by drum to a *.vexp file. This file is required for further use with
the Veda software.

The progress of an export is shown by the progress bar that opens.
A successful export is confirmed by a message.
The exported data are stored in the "Export" directory of the current
project, and can be transferred from there to the desired storage
location.
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5.08 Project Settings

5.08.01 Configuring the basic settings
Specify or change basic settings:
1. Select the Basic settings item from the Site pull-down menu. The

Basic settings dialog box opens.

2. In the Project type area, select whether earth work or asphalt work is
to be carried out.

Depending on the type of project, different window settings and
the appropriate setting options for creating and editing layers are
loaded.

3. Enter the Min. path difference from which the recording starts in the
Storage conditions area. If vibration is ticked, the HCQ software only
records measured data if the vibration is switched on.

4. Whether the passes are displayed separately for each drum or
brought together under machine passes is selected in the Passages
view area.

This affects only the display in the software. The data are
recorded separately for each drum.

5. The following variants can be selected in the Local time area:
Only UTC: Only UTC from the GNSS receiver is used.
Local time from PC: The time is recorded in UTC, and the
difference from the set PC time is calculated automatically.
User defined offset: Freely selectable difference between UTC
and the recorded time.

The difference is stored in the relevant project. If the project is
loaded onto another computer, the applicable local time always
appears with the recording.
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6. The backgrounds of the project settings are documented in the
Comment area.

7. Save the entries with OK.

5.08.02 Co-ordinate and reference system selection
HAMM HCQ software has an extensive data base with information on
a large part of the globally used co-ordinate systems (see page 93
sqq.). Thus, the user can work extensively in the view relevant for the
site.
For parameterizing the site-specific co-ordinate system:
1. Select the Coordinate system item from the Site pull-down menu.

The Coordinate and reference system selection dialog box opens.

2. Select the continent in which the site is located.

The recording is always made in UTM coordinates in the
WGS84 reference system. When a different coordinate and
reference system is selected, only the view is recalculated.

3. In the Country or Group field, carry out a further selection according
to regions and countries.

4. In the Co-ordinate System field, select the appropriate. 
Views are possible as polar co-ordinates or as map co-ordinates.

5. In the Reference System field, select the appropriate.

The usually used reference system is preselected for each
coordinate system. However, this can be freely changed in the
selection line Reference system .

6. In the Area (length / width) field, the application area of the co-
ordinate system - is indicated automatically - defined as polar co-
ordinates with origin equator and Greenwich meridian.

7. In the Notation (east / north) field, the following possible
constellations arise as a function of the reference system set:

s (preset): Place for zone, sector or meridian strip
s (added): Position for angular second
g: Place for angle degree
k: Place for kilometer
m: Place for meter and/or angle minute
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8. The coordinates can be adjusted precisely to the local measured
coordinate system in the fields East and North offset (metres)±.

9. In the Decimal Points field, adjust the number of the Decimal points
for the indicator of geo-coordinates.

10.Save your selection with the "Confirm" button and close the Co-
ordinate and reference system selection dialog box.

5.08.03 Creating and editing layers
To create new layers or change existing layers for a site:
1. Select the Change layer settings and add new layers item from the

Site pull-down menu. The Layer settings dialog box opens. The
available options are shown according to whether soil work or asphalt
work is being done.

Earthmoving
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Asphalt laying

2. Create a new layer using the "Insert" button and carry out the
required entries.
OR

3. Select an existing layer and carry out the required changes.
OR

4. Select the respective layer and use the "rename" button to rename
the layer.

5. Confirm the inputs with the "OK" button.
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5.08.04 Selecting layers
In order to select the layer to be edited:
1. Select the Layer item from the Site pull-down menu. The Layer

selection dialog box opens.

2. Select the required layer and confirm with OK.

5.08.05 Newly creating position points and calibration points - via the menu
1. Select the Measuring points item from the Site pull-down menu.

The Position and calibration input window dialog box opens.

2. Use the "Insert" button to open the Enter measuring point manually
dialog box.
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3. Assign the name for the new position / calibration point.
4. Select the type of measuring point.
5. Carry out entries in the areas GPS Co-ordinates and Co-ordinates in

the co-ordinate system.
6. With pressing the "Automatic insert of measured data" button the

data in the Roller measurement area are automatically entered by the
system. Manual input is not possible.

7. When pressing the "Manual insert of measured data" button, the
rows in the Measurement Rollers area are activated, the data can be
entered by hand.

8. Save the entries with "OK", the Enter measuring point manually
dialog box will be closed.

9. Create all required position/calibration points in this manner.
10.Save all entries with OK. The position and calibrating input

window is closed.

5.08.06 Newly creating position points and calibration points - with the
digitizer or mouse

1. Find the measuring point in the view frame and touch it with the
digitizer for about 2 seconds OR right-click with the mouse.

2. Via the Context menu that opens, "Copy to clipboard" the
coordinates.

3. Select the Measuring points item from the Site pull-down menu.
The Position and calibration input window dialog box opens.
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4. Use the "Insert" button to open the Enter measuring point manually
dialog box.

5. Accept the copied coordinates with the "Paste from clipboard" button.
In the Name area, a name is automatically assigned to the measuring
point. However, this can be changed.

6. Save the entries with "OK", the Enter measuring point manually
dialog box will be closed.

7. Create all required position/calibration points in this manner.
8. Save all entries with OK. The position and calibrating input

window is closed.
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5.08.07 Editing position and calibration points
To edit positions and calibration points:
1. Select the Measuring points item from the Site pull-down menu.

The Position and calibration input window dialog box opens.

2. The layer name and the name of the measuring point are shown
automatically in the centre of the upper part of the window.

3. In the Measurement point type area, you can see whether this is a
calibration point or a measuring point.

4. The position of the measuring point according to the set coordinate
system is shown in the Coordinates in coordinate system area.

5. The calibration method and the compaction value calculated with it
are entered in the Reference measurement area.

You will find more detailed information about the calibration
process in the Appendix.

6. Set the view of the measuring points in the Text direction,  View and
Colour areas.

7. The data calculated from the machine are shown in the Roller
measurement area.

8. Use the "Renaming" button to rename the measuring points when
required.

9. Delete measuring points with "Delete".
10.Measuring points can be loaded from a *.txt or *.csv file with the

"Import" button.
11.Measuring points can be written to a *.csv file with the "Export"

button.
12.Save all entries in the Position and calibration input window

pressing "OK".



Operating Software 
Project Settings 

72 2356591_00_BAL_HCQ_H900_en © HAMM AG 2013

5.08.08 Carrying out calibration
1. Select the Calibration item from the Site pull-down menu. The

Calibration dialog box opens.

2. Select the respective layer in the pop-up menu.
3. Select the calibration method that is to be used from the pull-down

menu. All available calibration points are shown in the table and the
graphic.

4. Enter the conditions to be used for the measurement with the roller in
the Conditions area.
Calibration points that were recorded under other conditions are
greyed out.
Other unsuitable calibration points can be deactivated in the table
with the relevant checkbox. These are shown in red in the graphic
and, together with the greyed-out calibration points, are not included
in the calculation.

5. When pressing the "Update" button, the HCQ software computes the
regression line.

6. A file name for the calibration can be entered in the Calibration name
field. This enables a number of calibrations to be saved for a single
layer.

The file name is automatically generated from the name of the
layer and a freely selected name.

7. Save with OK.
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5.09 Maps

5.09.01 Importing map

This option is only available for the "Expert".

Use the Import bitmap command in the Planning Data menu to
generate maps from bit maps.
All Windows bitmap types (*.bmp; 24 bit, , 256 colour, , 16 colour,
monochrome) can be imported.

The white areas of the imports are shown transparent. so
measurement data on white areas of the bitmap are not covered.

1. Select the Import bitmap item from the Planning data pull-down
menu. The Open dialog box opens.

2. Find and mark the desired map in the file system.
3. Import by clicking the "Open" button.

The map is always scaled to match the current view area.

4. Edit the map if necessary (see page 75)
5. Select the Save as... item from the Planning data pull-down menu.

The Save map as... dialog box opens.
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5.09.02 Selecting map
Selecting an existing map in the project:
1. Select the Maps item from the Site pull-down menu. The Map

selection dialog box opens.

2. Select one of the available maps from the Available area.
3. With the right arrow, import into the Selection for project area and

confirm with the "OK" button.

If a map from the Selection for project area is returned to the
Available with the left arrow, the project-specific settings of the
map are also accepted globally.
Use the "Recycle bin" button to remove a map from the project.
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5.09.03 Editing map
Maps can be inserted into and/or adapted to the area view. To do this,
the relevant command line in the Planning data pull-down menu has to
be activated. Active commands are identified by a tick.

Base Specify the anchor point around which the map
can be rotated and dragged.

Shift Moving the imported map.

Draw Expanding or contracting an imported map under
retention of the aspect ratio. 
The position of the specified anchor point (Base)
in the area view does not change.

Rotate Rotating an image around the specified anchor
point.

Save As A name can be assigned to the map in the Save
map as... dialog box. The files are copied under
this name into the global data directory. The map
is then available to all the projects on the PC,
and can be selected from the Site / Maps menu.

When a bitmap is imported, the centre of the image is
automatically defined as the anchor point (base).
Following deactivation with the same icon, a dialog box opens
for saving the changes made.
The raw data of the graphics with correctly set edge lengths
must be available because the side ratios are retained.
A map is always rotated and dragged around its anchor point.

5.09.04 Bringing map into the correct position
Bringing a map on the monitor into its correct, referenced position:
1. Create two reference points (see page 68 sqq.) and display them on

the screen.

Suitable reference points are, for example, the coordinates of
the top left-hand and bottom right-hand corners of the map.

2. Open the Planning Data menu.
3. Activate the Shift menu item, and move the map on the screen so

that the reference point of the bitmap coincides with the associated
measuring point set under 1.

4. Touch the Base menu item in the Planning data pull-down menu,
and use it to specify the coincident measuring points as the anchor
point (base).

5. Then deactivate the Base menu item.
6. Starting from the anchor point, move the map via the Planning data

/ Rotate menu so that the second reference point of the map lies
roughly in line with the associated measuring point.

7. Scale the map with the Planning data / Drag menu so that the
second reference point lies near the second measuring point.

8. If necessary rotate, drag and shift the map until the reference and
measuring points are coincident.
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9. With the Planning data / Save as menu item save the position
changes carried out. 
Now the card is available at any time for other projects, too.

Each map saved is automatically transferred into the database of
the HCQ Navigator software. It is then available to all projects on
the relevant PC.

5.09.05 Specifying map as the top layer
The map can either be used as a background or laid over all other
layers:
1. Click the Map as top layer menu item in the Planning data pull-

down menu. 
The project-specific map is laid over all layers. With renewed clicking,
the map is hidden again.

The underlying measurement and position data can be covered if
a map is used as the topmost layer.

5.10 Geolines
Traverse lines are auxiliary lines which represent edge limits (such as
the edges of a road) as traverses in the HCQ software. A line comprises
arbitrarily many, at least, however, two geo-referenced bases which
comprise the following information:

Identification and/or station name (optionally)
Longitude
Latitude
Altitude (optional)

5.10.01 Importing geolines
Prerequisites To import geo lines into the HCQ system, the following requirements

must be met:
1. The georeferenced points must be written in columns in a *.txt or

*.csv file. Only one point and its properties may be written in each
line.

2. The geodetic reference as well as co-ordinate system must be
known.
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Creating reference file 1. Use an editor to create a *.txt file with the data of the geo line (station
name, latitude, longitude and altitude of the individual geo points).

2. Space, tabs, semicolons and commas may be used as column
separators.

A full stop must be used as the decimal separator!

Import a geo-referenced point
file

1. Select the Import Geolines item from the Planning data pull-down
menu. The Import traverse lines dialog box opens.

2. Select the file to be imported with the "..." button in the Source area.
3. Select the first valid data row.
4. Columns: Which information has to be contained in each column

has to be specified according to the structure of the imported file. You
can also use files with more columns than are necessary. Only the
required information will be used.

If no station name is defined, the HCQ system automatically
defines the line number in the source program as station name.

5. With pressing the "Co-ordinate system" button, the Co-ordinate and
reference system selection window will open. This option is only
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required if the imported data is in a different coordinate and reference
system than the existing project.

The coordinate system used must be known so that the lines
appear correctly on the screen and in the printout.
If this information is not available, a similar system must be
selected. The geo line, hence, does not appear precisely on
the defined points; however, it can subsequently still be moved
in the image view or be turned. The result is thus usable as an
orientation line with low accuracy.

6. Open the window in the Target area with the "..." button and Enter
traverse line name. Enter a unique name for the traverse line that is
to be imported.

7. With pressing the "Import" button, the geo line is registered in the
software under the newly defined name. 
Now, the user can have them shown or even subsequently modify
them by rotating or moving. However, the latter means a loss of the
exact geo-referenced position.

5.10.02 Select geo lines
In order to select the geo lines required for the project:
1. Select the Geolines item from the Site pull-down menu. The

Traverse line selection dialog box opens.

1. In the Pool (all) area, select the required geo lines.
2. With the right arrow, import into the Selection for project area.
3. Tick geo lines whose station names should be indicated.
4. Confirm with "OK".

Use the recycle bin button to delete the selected geo line from
the current project only, but not from the pool of the geo lines! It
is thus available again at any time for another project.
You can transfer the project-specific settings of the traverse line
to the centrally saved line with the left arrow.
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5.10.03 Editing geo lines
Geo lines can be inserted into and/or adapted to the area view. For this,
the respective command line must be activated. Active commands are
identified in the Planning Data menu by a tick.

Shift Moving a geo line in the area view by Drag &
Drop.
Measuring data and position data can be coordi-
nated with the loaded geo lines (reference data).

Rotate Rotating a geoline around a reference point
in the area view. The reference point (rotation
point) is selected with the "Position info" button.
Afterwards, the geo line can be rotated.
Measuring data and position data can be coordi-
nated with the loaded geo lines (reference data).

Settings Opens the Geo line selection dialog box, with
which the view properties of the traverse lines
are accessed.

Following deactivation with the same icon, a dialog box opens for
saving the changes made.

Traverse line settings 1. Select the Geoline settings item from the Planning data pull-down
menu. The Traverse line selection dialog box opens.

2. Select the desired traverse line and confirm with “OK”.
3. The Transverse line settings dialog box will open.

4. The colour selection window is opened by clicking on the colour field
in the line colour area. Setting the desired colour for the geo line.

5. In the Text direction area, specify the position of the reference point
identification.

6. Use the "Co-ordinate system" button to open the Co-ordinate and
reference system selection dialog box. The original settings can be
corrected here.

7. Save the settings with "OK".
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5.10.04 Manual Referencing Traverse Lines
Bringing a geo line map on the monitor into its correct, referenced
position:
1. Selecting an available geo line (see page 78).
2. Activate the Shift traverse lines item in the Planning data pull-down

menu.
3. Use the hand icon to move the geo line into the desired position.
4. Activate the Rotate traverse lines item in the Planning data pull-

down menu.
5. Specify the rotation point with the "Position info" button, and click the

desired reference point of the traverse line.
6. Turn the geo line into the desired direction.
7. A save query appears when the two menu items Shift traverse lines

and Rotate traverse lines are deactivated.

Once the geo line has been saved, it can be loaded at any time
for other projects, too. The geo line is independent of the project.

5.10.05 Specifying station view
To show / hide station names of geo lines:
1. Select the Stations item from the Planning data pull-down menu.

The project-specific identifications (position data) of the stations of a
geo line are shown/hidden.

5.11 Screen Set Up

5.11.01 Specifying screen layout
To switch between full image display screen and split screen:
1. Select the Split screen item from the View pull-down menu.

The view changes between split screen and full image display
screen. 
OR

2. In the button bar, click the "View selection" button and tick "Split
screen" or remove the tick.

5.11.02 Specifying window settings
With split screen, a maximum of five different views can be displayed on
each side of the screen.
Specifying the views in the respective project:
1. Select the Window settings item from the View pull-down menu.

The Window settings dialog box opens.
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2. In every column in the pop-up menus, select which 5 windows should
be able to be selected on the screen.

3. Save with OK.

Once these settings have been specified, the predefined windows can
be called up at any time via "View selection" button in the button bar.

5.11.03 Background colour and text colour change
In order to change the colour view in the viewers:
1. Open the relevant Settings or the Window legend dialog box with

the "Change" button in the legend.
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2. Click on any colour field. 
OR
Select the preselected palette from the "Preselected palettes"
window, and accept with "Set palette". 
The dialog box Settings for background and text colors is opened
in order to assign to passages, value areas, quality steps or layers
any background colour and text colour desired.

Background change

Change text colour

Opens the Colour dialog box with a colour
palette primary colours and user-defined colours.
Using the "Define colour" button, other colours
are added to the user-defined colour palette. Fi-
nally, confirm the selection with "OK".

3. After return to the Settings dialog box, save the entries with
"Confirm".

5.11.04 Changing values and value areas
To change the value areas which are assigned to the colour fields:
1. Use the "Change" button in the legend to open the respective

Window legend orSettings dialog box.
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2. Set values and value areas using the buttons in the individual areas.

Minimum / maximum value Manual input of the measurement range
that is to be resolved. The scale is adjust-
ed automatically.

Adapt value area The colour scale is scaled automatical-
ly on the basis of the recorded measured
values.

Preselected palette Selection of a predefined colour palette

Cancel Quits this dialog. Changes already made
are lost.

3. Save all entries with "Confirm".

5.11.05 Zoom
1. Use the View menu to click on the desired zoom versions, the view is

adapted as desired.
OR

2. Select the Zoom tool from the toolbar (see page 34 sqq.). Specify the
area that is to be zoomed into by clicking and dragging in the view
frame.
OR

3. Use the Zoom in / Zoom out buttons on the Panel PC.

 

5.12 Evaluations

5.12.01 Replay
Subsequent analysis of the measuring procedure:
1. Select the Replay item from the Analysis pull-down menu. The Data

replay dialog box opens.
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2. From the pull-down menu, select the roller / drum whose measuring
pass is to be displayed.

3. Press the ">" button. The recorded measuring procedure is played.
4. With the buttons "+" and "-" you can change the replay speed.
5. With the "x" button, you can close the window.

5.12.02 Carrying out filter settings
In order to consider only specific layers, machines, timeframes or
measured values in the Replay, these can be selected in the Filter
settings window:
1. Select the Filter item from the Analysis pull-down menu. The Filter

settings dialog box opens.

2. Click the "Show all / Hide all" button in the Layers or machines area.
All available records are shown or hidden simultaneously 
OR
Press the "Change" button. The particular selected record is shown
or hidden.
OR
Double-click the line to be shown or hidden.

3. Select it in the Compaction mode area.
4. Select the desired option in the HCM double jump area.
5. In the Temperature area, adjust the temperature range desired for the

analysis.
6. In the Height area, enter the height range desired for the analysis.
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7. In the Timeframe area, adjust the period desired for the analysis.
8. Select the direction of travel to be considered in the Direction area.
9. Using the "Filter on" button, activate the configured filter settings. The

"Filter active" icon appears in the toolbar.

10.Using the "Filter off" button, deactivate the configured filter settings

5.12.03 Carrying out points analysis
To analyze select points on the site:
1. Select the Point analysis item from the Analysis pull-down menu.

OR
In the tool bar, click on the "Position history" button.
The cursor changes to a flag.

2. By clicking with the mouse, put an analysis point on the compacted
surface. 
The Point analysis dialog box opens. 
The position together with latitude, longitude and the number of
passages are stated in the upper part.

3. Select the measured value that is to be shown in the diagram from
the pull-down field.

The available measured values depend on whether work is done
in soil work or asphalt work.
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4. Click the Point analysis menu line or "Position" button again to
disable the function.

5.12.04 Carry out distance measurement
Quick measuring of sections on the site:
1. Select the Distance measurement item from the Analysis pull-down

menu.
OR
In the tool bar, click on the "Distance" button. 
The cursor changes to a ruler.

2. Click the starting point and drag the ruler to the end point. The
starting point, end point and the distance of the last measurement are
shown below the legend.

3. Click the Distance measurement menu line or "Distance" button
again to disable the function.
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5.13 Archiving
Archiving the site data occurs with an USB-Stick:

Plug USB-Stick into one of two USB ports.
Click the "Archiving" button on the button bar. 
A window opens with the Directory view. The target path is already
preset on the stick. With the "OK" button, you can start the storage
process.
After successful archiving, the message "Storage process finished"
appears.

The folder name of the data backup is complemented by date
and time of the storage process.

The data thus saved can be viewed at any time on any computer with
HCQ software and be processed. For this, the saved folder must be
copied by hand via file managers into the project folder in the user
directory.

5.14 Communication - Work with several rollers
Prerequisites In order to communicate with multiple rollers on a single WLAN data

network, the following entries must be made in the system:
the roller designations and
the assigned IP numbers.

The settings can be made in the file HAMM-Net.txt in the
"Settings" project directory.

Communication Enter the roller that is to be integrated into the particular network:
1. Select the HAMM network item from the Communication pull-down

menu. The Communication dialog box opens.
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2. Enter the drums that are to be displayed one beneath the other in the
left-hand "Drum" column.

Only the data of the drums entered here will be acquired.

3. Enter the IP addresses of the rollers or Panel PCs that are to be
connected in the right-hand "IP Panel PC" column.

Each Panel PC has a permanently set IP address, which you
are given by your Wirtgen Group service partner or is to be
found on the corresponding sticker on the enclosure.

4. Save inputs with "OK".

The connection is established as soon as the entered Panel PCs
come into range. If no WLAN network connection exists at HCQ
program start to all active machines, an error message appears.
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5.15 Printing
To print selected windows:
1. Select the Print item from the File pull-down menu. 

OR
Click the "Print" button in the toolbar
The Print window dialog box opens.

2. The pages to be printed can be selected in the check boxes.
3. Enter it in the Scale for printing area.
4. Select the desired option in the Range of print area.
5. Use the "Printing device" button for the required setup.
6. Use the "Print" button in the preview window to start the printing

process.
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6 TAKING OUT OF SERVICE
6.00 Panel PC

Switching off When shutting down the panel computer, no data will be lost.
All measurement data are automatically saved during the
measurement recording.

1. By pressing the "Stop" button the measuring procedure ends.
2. Stop rollers.
3. In the menu File press on the Exit menu line. The software is closed

down.
4. Switch off panel computer with on / off button (left side).

Dismantling Find out about the decommissioning of the rollers in the
operating instructions of the respective machine.

5. Shut off the rollers with the ignition key.
6. Unlock panel computer holder with key [C].
7. Push the locking lever [A] on the vehicle's PC holder down.
8. Remove computer from the open holder.
9. Keep computer in the case provided.
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6.01 Receiver

 WARNING
Danger of falling! Danger of injury!
Only dismount the receiver when the machine is switched off.
During disassembly, pay attention to stable footing!

 
1. Connectors [D] of the GPS cable must be released at the receiver [B]

and be plugged into the intended fixture.
2. Unplug the GPS cable [C] from the socket on the machine roof [A],

and seal the socket with a screw plug.
3. Remove the receiver on the magnetic feet from the machine roof [A],

and store it in the case supplied.

6.02 Office computer
Shut down the HAMM computer software at an office computer:
1. In the File menu, click the Exit menu line. 

The software is closed down.

6.03 Uninstalling software
Uninstall the software on the office computer when required, using the
operating system.
Windows Start Menu / Control Panel / Programs and Functions
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7 APPENDIX

7.00 Directory structure
HCQ- file directory The file directory of the HAMM-HCQ-Software, HammHcqData, is

located in the public user directory. As a function of language and
operating system, this is as follows:

Windows XP, German: C:\Dokumente und Einstellungen\
HammHcqData
Windows XP, English: C:\Documents and Settings\HammHcqData
Windows 7: C:\Users\Public\HammHcqData

 
The folder structure within the directory HammHcqData is as follows:

Calibration Global calibration information

Dictionary Country-dependent menu texts

Lines Geolines

Maps Bitmaps (maps...)

PrintView Cover sheet and End page for print out-
put

Project Folder for projects

Default Project Sample project with default settings

Calibration Calibration Defaults

Dictionary unused

ErrorData unused

Export unused

Planning
Data

unused

Lines unused

Maps unused

Project Default view settings...

Settings Default settings for window, co-ordinate
system, network...

Project1 User project; The name can be freely
chosen by the user.

Calibration Calibration data

Dictionary Menu texts of the currently set language

ErrorData Measurement data with e.g. storage con-
ditions that have not been not fulfilled

Export unused

Planning
Data

Planning sata (bitmaps, geolines)

Lines Geolines

Maps Maps as bitmaps

Project Measuring data
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Settings Settings for window, co-ordinate system,
network...

Project2

...

In every HammHcqData folder, a project called Default Project is created
automatically at installation. This contains all basic settings which then
again serve as a default for the new creation of projects. In the Open
project dialog box, this project is not visible.

HCQ program directory The program directory can be freely chosen by the user at the time of
installation. Typically:
 
Windows XP
C:\Program Files\HCQ Navigator or
C:\Program Files\HCQ Navigator
 
Windows 7
C:\Programme (x86)\HCQ Navigator or
C:\Program Files (x86)\HCQ Navigator

7.01 DGPS Correction Signal Versions
According to use, GPS-positioning systems deliver different accuracies.
Absolute accuracy of GPS-positioning methods

Positioning method DGPS Near absolute accuracy

RTK with local base station 2.5 cm / 1 in

OmniSTAR HP 15 cm / 6 in

OmniSTAR VBS 75 cm / 30 in

WAAS/EGNOS 1 m / 40 in

7.02 Coordinate System
The HCQ system receives the position information in the notation usual in the GPS: "degree". The
latitudes, here, have their origin in the equator, the longitudes in the prime meridian in Greenwich. The
height information is received as height above the geoid ( corresponds, about, to the sea level) in meters.
The position here refers to the so-called reference ellipsoid WGS84 (World Geodetic system in 1984).
Positions, however, are mostly depicted in land surveying and in road construction in co-ordinate
systems specific for region or specific for country. HAMM HCQ software has an extensive data base
with information on a large part of the globally used co-ordinate systems that allows the user to work
extensively in the view relevant for the site. Parameterizing the site-specific co-ordinate system is via the
window "Co-ordinate and reference system selection".

7.02.01 Types of co-ordinate systems
There are various types of co-ordinate systems. Views are possible as polar or as map co-ordinates. In
addition, every system has an individual origin, which is often defined independent of the equator or the
Greenwich meridian.
The most familiar ones are:
Geographical co-ordinates (Greenwich) [degree]
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Range (L / B): -180 to +180 / -090 to +090 degrees
Notation (E / N): ±ggg / ±gg

UTM co-ordinates (northern hemisphere)
Range (L / B): -180 to +180 / -089 to +089 degrees
Notation (E / N): sskkkmmm / ±kkkkmmm

Gauss Krüger co-ordinates (3 degree-wide strips)
Range (L / B): -180 to +180 / -089 to +089 degrees
Notation (East/North): ssskkkmmm / ±kkkkmmm

7.03 Reference Systems
The reference system and/or rotation ellipsoid forms the basis for the co-ordinate systems of geopositions.
The geo co-ordinate systems model the earth as a rotation ellipsoid which corresponds as exactly as
possible to the dimensions of the earth. The axes are designed in each case so that the axis for the region
to be surveyed optimally corresponds to the earth's surface. The measures of this ellipsoid are determined
with the equator axis (big half-axis) as well as the polar axis (small axis). In addition, this model is fixed at
several earth points.
Customary reference systems are as follows:

WGS84 (World Geodetic System 1984) with WGS84 ellipsoid
ETRS89 (European terrestrial reference system 1989) with GRS80 ellipsoid
DHDN (German main triangle network) with Bessel ellipsoid

The HCQ software uses these reference systems for the surface co-ordinates of the geopositions, i.e. for
longitude latitude determination.
The Geoid, which defines surfaces with the same gravity field all around the globe, is used in geodesy ,in
addition to the ellipsoid model, for height interpretation. The heights are documented thus as height relative
to the geoid, which roughly corresponds to the common height above the sea level. The model integrated
in the HCQ - regardless of the set reference ellipsoid - is always the globally used WGS84-EGM96.

7.04 Geo Points
The HCQ system allows for the option to save geodetic positions combined with extra information as data
records. Here, we basically distinguish between two types of points:

Info point : assigns to a position a name as well as a comment.
Calibration point: assigns to a position and measured data determined by the rollers, a reference
measurement value, in addition.

7.05 Soil Compaction Reference Values
Soil type Recommended setting (last pass) HMV

range
Stiffness /
load capacity

Silty / loamy soils with
excessive water content

large amplitude
maximum frequency
speed: 2 - 2.5 km/h

0 - 5 low

Silty / loamy soils with the 
correct water content

large amplitude
maximum frequency
speed: 2 - 2.5 km/h

5 - 15 low

Sandy soils / gravely soils small amplitude
reduce the frequency by 5 - 8 Hz
(Hammtronic only!)
speed: 2.5 - 3 km/h

15 - 30 medium
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Soil type Recommended setting (last pass) HMV
range

Stiffness /
load capacity

anti-freeze compound /
base layer material /
HGT

small amplitude
reduce the frequency by 5 - 8 Hz
(Hammtronic only!)
speed: 2.5 - 3.5 km/h

30 - 50 high

Rock small amplitude
reduce the frequency by 5 - 8 Hz
(Hammtronic only!)
speed: 2.5 - 3.5 km/h

50 - 100 very high

7.06 Recommended Working Depths
This overview shows the working depths of the various types of vibration rollers at a large amplitude and
maximum frequency.

Deviations from reference values are possible!
The working depths are correspondingly halved at a small amplitude. The stated values must be
regarded as guide values, and can vary widely under different soil conditions.

Soil typeMachine
type Rock Sand / gravel Clay / loam / silt

3205 25 - 30 cm (9.8 - 11.8 in) 15 - 20 cm (5.9 - 7.9 in)

3307  28 - 40 cm (11.0 - 15.7 in) 20 - 25 cm (7.9 - 9.8 in)

3410, 3411 50 - 70 cm (19.7 - 27.6 in) 42 - 50 cm (16.5 - 19.7 in) 25 - 35 cm (9.8 - 13.8 in)

3412 70 - 85 cm (27.6 - 33.5 in) 50 - 65 cm (19.7 - 25.6 in) 28 - 40 cm (11.0 - 15.7 in)

3414 85 - 105 cm (33.5 - 41.3 in) 60 - 70 cm (23.6 - 27.6 in) 30 - 42 cm (11.8 - 16.5 in)

3516 97 - 125 cm (38.2 - 49.2 in) 67 - 80 cm (26.4 - 31.5 in) 30 - 40 cm (11.8 - 15.7 in)

3518 110 - 140 cm (43.3 - 55.1 in) 72 - 95 cm (28.4 - 37.4 in) 35 - 45 cm (13.8 - 17.7 in)

3520 125 - 155 cm (49.2 - 61.0 in) 90 - 115 cm (35.4 - 45.3 in) 37 - 52 cm (14.6 - 20.5 in)

3625 150 - 195 cm (59.0 - 76.8 in) 120 - 160 cm (47.2 - 63.0 in) 45 - 55 cm (17.7 - 21.7 in)
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7.07 Calibration

7.07.01 General
Information about compaction is initially gained during a measuring procedure by looking at the course of
the measurement value changes.
An allocation of these measured data to absolute values (e.g., load-carrying capacity EV2) is possible only
by previous calibration by means of conventional measuring systems. Therefore, it is possible to determine
relevant evaluation parameters from the compaction measurement (HMV).
The calibration produces, by means of conventional processes (e.g., bearing plate, Proctor) a linear
connection between the compaction measured data of the machine (HMV) and the load-carrying capacity
(e.g. EV2) or other alternative physical evaluation parameters of the ground.

7.07.02 Advantages
The stiffness value HMV measured by the machine is measured dynamically, i.e. by the compaction
frequency vibrating in the vibration frequency.
For the acceptance of the work, the static load-carrying capacity of the ground is to be proven, something
that, however, means a lot of time involved and therefore can only be carried out selectively. In many
areas, therefore, a linear connection exists between both measurands when observing some instructions.
Thus, it is possible, for instance, to draw conclusions - from a calibration of the dynamically measured
dimensionless HMV value - concerning dimension-related ground load-carrying capacity values like EV1 or
EV2.
The following requirements must be met:

The parameters of speed, amplitude, compaction frequency and direction of movement during
measuring procedures must precisely correspond to those of the calibration.
The calibration applies for the same ground and the same underground conditions, i.e. typical for a
given layer.

After calibration, it is possible to comprehensively survey the ground with the rollers, using the unit relevant
for the load-carrying capacity, e.g., EV2 in MN/m².

7.07.03 Prerequisites
The basis of the calibration are at least three value pairs (HMV reference values) which are saved in geo
points and were determined under equal conditions:

Driving speed
Amplitud
Compaction frequency
Driving direction
All HMV roller measured data must have been determined with an identical machine.
The measuring method of the reference measured data must be identical.
All the calibration geo points consulted for reference must be assigned to the same layer.
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8 MAINTENANCE
8.00 Recharging Battery

Charging the batteries see page 52 sqq.

8.01 Changing the Battery
Removal of the battery 1. Switch off panel computer with on / off button (left side).

2. Disconnect panel computer from power supply (see page 90 sqq.).
3. Press battery catch with a pin.
4. Move battery lock in the direction of battery catch.
5. Remove the battery.

Inserting the battery 1. Insert new battery into the empty battery compartment.
2. Press battery downwards.
3. Return the battery lock into its starting position.

The battery catch engages and the battery is secured.

The switched off panel computer can be stored for 30 days with
charged battery.

8.02 Replacing the Digitizer
By constantly using the digitizer, the tip can wear out and scratch the
screen.
In the case of appearance of the following problems, please replace the
digitizer:

The digitizer no longer moves easily across the screen.
The digitizer is not working properly anymore.

Further information on this is available in the panel computer manual
that is part of the scope of delivery.

8.03 Caring for your Screen
NOTICE

Damage to the screen!
Alcohol can damage the computer screen!
Do not use any alcohol-based detergents!

 
Carefully wipe the screen with a soft, moist cotton cloth.

By leaving on or re-applying the protective film provided to the
screen, you can protect your screen from wear and tear.
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